Unicenter® Service Desk r11.1
Integrating with CA Workflow

Last Updated April 17, 2006
Table of Contents

I. CA Workflow Overview ..................................................................................................................................................... 3
   Basic Terminology ............................................................................................................................................................ 3
   CA Products that Ship CA Workflow ............................................................................................................................ 5
   Description of Each Activity Node ............................................................................................................................... 5

II. Sample CA Workflow Set Up - How To ........................................................................................................................... 6
   Environment...................................................................................................................................................................... 6
   Installation......................................................................................................................................................................... 6
   Create Contacts in Unicenter Service Desk and eIAM..................................................................................................... 9
   Configure Workflow 11
   Configure Change Order in Unicenter Service Desk......................................................................................................14
   The Sample Workflow in Action......................................................................................................................................15

III. Troubleshooting and Additional Resources ..................................................................................................................21
   Log Files .........................................................................................................................................................................21
   Install/Uninstall................................................................................................................................................................21
   Additional Resources......................................................................................................................................................22
   Common Errors ..............................................................................................................................................................22

IV. Enhancements..............................................................................................................................................................25
   Creating a Duplicate of the Sample Workflow ................................................................................................................25
   Update the Unicenter Service Desk Activity Log............................................................................................................26
   Set due dates for tasks...................................................................................................................................................29
   Retrieve a User’s Supervisor from Unicenter Service Desk...........................................................................................33
   Modify Exception Handling .............................................................................................................................................34
   Create / Update Forms ...................................................................................................................................................35
   Integrating CA Workflow with Other Applications ......................................................................................................37

Copyright © 2006 CA. All rights reserved. All trademarks, trade names, service marks and logos referenced herein belong to their respective companies.
I. CA Workflow Overview

The goal of the Order PC Sample Workflow is to demonstrate the functionality of Unicenter® Service Desk r11.1 and the out of the box integration with CA Workflow. The sample workflow is designed to show a first time user a simple process where an employee requests a new PC followed by an approval phase. Throughout the process the workflow updates the Service Desk Change Order that originally triggered the workflow.

This document will walk you through the configuration and set up of the Service Desk and Order PC Sample workflow integration. With the out of the box install of Service Desk and CA Workflow there are only a few minor changes that need to occur to get the Sample working. However this document goes through step by step to verify that all settings are correct and also covers optional settings to further tailor the sample.

Please review the CA Workflow help (within the IDE), specifically sections on “About the Workflow Environment”, “Workflow Concepts”, and “Creating Workflows Overview” before configuring the sample CA Workflow.

Basic Terminology

- CA Workflow
  - Sometimes referred to as workflow
  - The embedded component that integrates with Unicenter Service Desk
- Basic Workflow
  - Unicenter Service Desk 6.0 style Workflow
  - The 6.0 style workflow can still be used with Unicenter Service Desk r11.1
  - This term is only used from a Unicenter Service Desk perspective
- Advanced Workflow
  - CA workflow which can be integrated with Unicenter Service Desk r11.1
  - This term is only used from a Unicenter Service Desk perspective
- eTrust® Embedded Identity and Access Management (eIAM)
  - The authentication and contact repository for CA Workflow
  - Also known as eIAM and eTrust Embedded IAM
- Process
  - A series of steps that occur to accomplish a goal
- Process Definition
  - A process saved in CA Workflow
- Process Designer
  - Tab in the Workflow Design Environment where you design the process
- Attribute
  - Variables that hold info required for the process
- Actor
  - Anything in the workflow that can perform activities
  - Person, Web Service, Java Code, Group, etc.
  - Different types have different capabilities
- Role
  - Function performed by an Actor
  - Customer Service, Analyst, etc
- Node
  - The basic building block of a process
  - Can be of many types (discussed later)
- Activity
  - Node signifying some task is being performed
  - No hint as to what the task being performed is
o No hint as to who is doing the task
o Is performed by a role
o Options depend on the actor playing the role
o Can show forms to a user, but not to Java code

- (Process) Instance
  o A single running of a defined process
  o New one created every time you run the process
  o Still in a “running” state

- (Process) Instance History
  o Historical account of what occurred during a single process run
  o Same as above, but no longer “running”

- Web Service
  o Type of actor that be used to fulfill a role to perform an activity
  o Actions are the public/exposed methods

- Java Object Actor
  o Custom Java code that can be used to fulfill a role to perform an activity
  o Actions can be exposed methods
  o No persistence
  o Does not remember changes made to the object between activities

- Java Object
  o Same as Java Object Actor, except has persistence

- Data Type
  o Used to expand the default set of attribute types

- Due Date
  o A way to specify that an activity must occur in x amount of time

- Expression Editor
  o Dialog used throughout the tool to create expressions that evaluate to attributes
  o Based on XPath
    Ex: $price = $cost * $quantity

- Workitem
  o A task that is assigned to a user

- Worklist
  o Web interface for end users to complete workitems

- Task
  o Another name for workitem

- External Attribute
  o An attribute that has been “checked” external will show when you select a process instance
  o If not “checked” it will show only when you open the instance

- Server Log
  o A tool in the Workflow Design Environment that is helpful in debugging processes as you design them
  o Shows any errors that occur while running the process
  o HINT! Always turn on during process design/testing!!!!

- Process Actor
  o Type of actor that allows one process to call (start/stop/query) another

- Process Parameters
  o Used to pass data into the process and get data out of the process
  o Can only be simple default types

- Global User List
  o List of all users and groups stored in eIAM

Copyright © 2006 CA. All rights reserved. All trademarks, trade names, service marks and logos referenced herein belong to their respective companies.
• **Branch**
  o A way to specify to take one of many paths in a process

• **Fork**
  o Specify to take all paths at the same time
  o Parallel processing

• **Merge**
  o Being divergent paths together
  o First in gets through

• **Join**
  o Bring divergent paths together
  o Waits for all before continuing

---

**CA Products that Ship CA Workflow**

The following CA applications embed the CA Workflow engine today:

- Unicenter® Service Management 2.2 and r11
- Unicenter® Service Desk r11
- Cleverpath® Aion BPM 10.1
- eTrust® Admin 8.1 SP1

Longer term CA is looking to add additional products to this list.

---

**Description of Each Activity Node**

Each step of the workflow process is considered a “workitem” in the CA Workflow Design Environment. For more information on the different available nodes and the functions of each of them please refer to “Workflow Concepts” in the online help.

*Please note that this sample process mimics a user requesting a new PC and the process that takes place to approve that request. This is just a sample that demonstrates the capabilities of CA Workflow integrated with Unicenter Service Desk. A real PC Order process may utilize a Service Catalog and integrate with other systems not included in this sample.*

(See the screen shot below to view the entire process within the designer interface)

• **Start**- Designates the beginning of the workflow

• **Get Object Info**- Using a separate workflow or process definition as an actor, passes selected attributes such as the assignee, requester and affected end user attributes to retrieve from the change order that triggered the workflow

• **Wait for Process**- This event node waits for the previous step to complete before proceeding

• **Save Attribute Info**- Saves the values of the Change Order attributes. Uses XPath to parse out the XML data returned from Get Object Info workitem, and saves these values in attributes for later use
  o **Note:** For more information on using XPath for XML parsing, you can reference:
    - [http://www.w3schools.com/xpath/default.asp](http://www.w3schools.com/xpath/default.asp)

• **Notify End User**- Notifies the End User through Service Desk notification to login to their worklist and complete an online form

• **RequestForm**- Displays the user designed online Request PC Form and prompts the end user for input

• **Email Approver Form to Approver**- Sends an email through CA Workflow to the Approver role notifying them of a request for approval in their worklist

• **Approve Form**- Displays the basic online Approval Form and prompts the Approver for input

• **Approve Decision**- This Branch node takes input from the Approval Form and based on the answer will notify the end user via email through Unicenter Service Desk of approval or rejection

Copyright © 2006 CA. All rights reserved. All trademarks, trade names, service marks and logos referenced herein belong to their respective companies.
II. Sample CA Workflow Set Up - How To

Environment

The following are details about the machine configuration that was used to build this document. This configuration is not required.

- Unicenter Service Desk R11.1 GA / CA Workflow Version 1.0.019.005 (Build E20051004)
- SQL 2000, Windows 2000 Server SP4 GIS Patch 11.11
- 2.40 GHz processor, 8 GB Disk Space, 1 GB RAM

Installation

- Note: `<localhost>` is used in the urls within this document, please replace with your hostname!
  1.) Install Unicenter Service Desk by selecting "Install Unicenter Service Desk r11.1" from setup.

Copyright © 2006 CA. All rights reserved. All trademarks, trade names, service marks and logos referenced herein belong to their respective companies.
Note: “Install CA Workflow” is not used for the initial CA Workflow install but rather to install a remote workflow client to connect to an existing CA Workflow server. This allows a workflow engineer to create and update workflow process definitions without having to login to the server directly. The initial CA Workflow installation is completed as a part of the Primary Server configuration.

2.) As indicated above, run Unicenter Service Desk configuration as a part of the installation.

3.) The CA Workflow user name and password will default to Privileged User Name and Privileged User Password that is entered during the System Accounts step. In our case it is going to be user “ServiceDesk”, with “servicedesk” (note case here) as the password.

Note: Please keep note of this as we will use this user throughout the rest of the document.

4.) Note that Tomcat is required to run CA Workflow. During configuration you can select to use Tomcat only, or a combination of Tomcat and IIS within Unicenter Service Desk. During configuration, you also specify which ports will be used. You can verify these ports after running configuration by checking $NX_ROOT/nx.env, or through the Workflow options in Options Manager.

Note: By default Unicenter Service Desk’s instance of Tomcat uses port 8080. If this port is already in use by another application, you will need to change the port. You can determine if a port is already in use by running the following utility from a command prompt: netstat –a. For more information on using netstat, see Windows Help.
5.) Enable eIAM as the authentication mechanism for Unicenter Service Desk only if you want the CA Workflow and Unicenter Service Desk contacts to use the same authentication tool. This is NOT required for using CA Workflow or for getting the Order PC Sample working; however this does make the administration and integration of contacts easier. If feasible, point both Unicenter Service Desk AND eIAM at the same LDAP repository so contact information is more easily synchronized.

6.) Again, please note that CA Workflow is installed automatically during the configuration. Once you have completed the interview process, you will see CA Workflow configured and integrated:

7.) When configuration is complete, you should see a message in $NX_ROOT/log/configure.log: “CA Flow install successful”:

Copyright © 2006 CA. All rights reserved. All trademarks, trade names, service marks and logos referenced herein belong to their respective companies.
Create Contacts in Unicenter Service Desk and eIAM

To effectively use the sample, you need to have a Requester of the new PC and an Approver of this request. The requester must be a user in both Unicenter Service Desk and eIAM. The approver can be both, but is only required to exist in eIAM. eIAM is the authentication mechanism and contact store for CA Workflow. In our example here are the players:

- **Requester** -> Name: William Requester  
  Userid: requester

- **Approver** -> Name: Mary Approver  
  Userid: approver

The following steps will cover all the settings to create contacts in Unicenter Service Desk and eIAM for the sample workflow.

1.) Login to the eIAM web interface at [https://EIAMSERVERNAME:5250/spin/eiam/eiam.csp](https://EIAMSERVERNAME:5250/spin/eiam/eiam.csp). The “EIAMSERVERNAME” is the name of the server where eIAM is installed. This may be localhost or it could be the remote server where the MDB (Management Database) is installed. Be sure to login with the “Service Desk” application instance which by default is “ServiceDesk-<machine name>“. Login using the Privileged User Name and Privileged User Password that was set during configuration. As mentioned earlier, our user is “ServiceDesk” with a password of “servicedesk”.

- **Note**: You can also login as the EiamAdmin user who is the Administrator of the eIAM application. The eIAM Admin password is set during Service Desk configuration. This user is not an OS user. If you do not remember the EiamAdmin password, please contact Support and they can help you recover or reset the password.

Copyright © 2006 CA. All rights reserved. All trademarks, trade names, service marks and logos referenced herein belong to their respective companies.
2.) From the Manage Identities tab, click Go to search for all users. By default only the ServiceDesk and machine Administrator users exist in eIAM. To create a new user, click the New User icon to the left of the Users folder on the lower left part of the screen (See screen shot below). You will need to create a user for the Requester and Approver in the workflow. A single admin contact (ex:ServiceDesk) can be used to perform all tasks within the workflow but to make it more realistic it's best to have both a requester and approver.

3.) Create the Requester contact in eIAM and Unicenter Service Desk. When created in both applications, be sure that the userid for both is “requester”. Ensure to give an email address within Unicenter Service Desk to the Requester contact by going to the contact detail within Unicenter Service Desk. For this example all screen shots use the user “William Requester”.

4.) Create the Approver in eIAM and Unicenter Service Desk. Out of box the Approver is set to the assignee of the Change Category that is launching the Workflow Process Definition, so you will need to assign this user to your Change Category. Give an email address within eIAM for the Approver contact, for this example the user is “Mary Approver”. Be sure that the userid both in eIAM and Service Desk, are set to “approver”.

Copyright © 2006 CA. All rights reserved. All trademarks, trade names, service marks and logos referenced herein belong to their respective companies.
Note: This is just an example. As mentioned earlier, the approver can easily be changed to any user, or any attribute, and this user does not necessarily need to be an analyst OR even exist in Unicenter Service Desk for that matter. The requirement is only that the Approver exists in eIAM.

5.) While in eIAM, verify that the ServiceDesk user, or the appropriate CA Workflow Administrator as defined in Unicenter Service Desk configuration, is a member of the Workflow Process Initiator Group. By default Unicenter Service Desk launches all workflow processes using this actor.

Configure Workflow

1.) Login to the CA Workflow Design Environment as the ServiceDesk user with password of servicedesk. The CA Workflow Design Environment can be accessed by going into Start/Programs/Computer Associates/Unicenter/Service Desk/Workflow IDE.

Copyright © 2006 CA. All rights reserved. All trademarks, trade names, service marks and logos referenced herein belong to their respective companies.
Once you are logged in, double click the “Login – Unicenter Service Desk” workflow process to verify the login parameters are correct:

2.) Now double click the “Call Login” Activity Node, which invokes the login to Unicenter Service Desk (See screen shot below). The default username and password is ServiceDesk, with the same case. This is the user that will login to Unicenter Service Desk via the web services. This user’s rights and security are designated by their Access Type in Unicenter Service Desk. Feel free to change this username and password, but ensure that they have the ability to perform basic functions such as creating and updating tickets in Unicenter Service Desk. If the ServiceDesk user password is incorrect for what you have set during configuration, which in our case it is, you will need to change it here and then save the updated workflow process. In our case we are going to leave the ServiceDesk user, and change the password to “servicedesk” all lowercase. Just clicking OK within the activity does not save the entire workflow process, you must click the save button to update the process definition:
3.) Out of the box the approver of the Order PC Workflow is assigned to the Assignee of the Change Category launching the Workflow, the corresponding attribute is $ApproverUserid. You can reassign the approver role to a different user, or different attribute, by going to the Order PC Process Definition and navigating to the Roles tab at the bottom of the screen. The Online Help refers to a Role as "a business function performed by an actor":

Copyright © 2006 CA. All rights reserved. All trademarks, trade names, service marks and logos referenced herein belong to their respective companies.
4.) Also verify that CA Workflow is configured to send emails. Do this by going to the Server Configuration Tab, and entering a valid SMTP server name in the SMTPHost field. Be sure after your changes are made that you hit the save button.

**Configure Change Order in Unicenter Service Desk**

1.) Create a new Change Category within Unicenter Service Desk by going to Administration/ServiceDesk/Change Orders/Categories. Create a new category PC.Order by hitting the Create New button.

2.) Fill out the details of the Change Category including the Assignee, which should be set to Mary Approver. Then go to the Workflow tab. Click on “Use CA Workflow”, and select “Order PC – Service Desk” Workflow definition from the list of
workflows.

- **Note:** This list only shows definitions that relate to Unicenter Service Desk. To view your own custom process definition within Unicenter Service Desk you must have an external string variable named `usd_persid` defined in the definition otherwise it will not be known to Unicenter Service Desk (Please see section on “Common Errors – Inability to attach Process Definitions to Service Desk Change or Issue Categories” for more information on this):

After you are finished editing the change category click save. The new category is shown below with the id of the CA Workflow listed on the workflow tab.

The Sample Workflow in Action

1.) Create a new Change Order within Unicenter Service Desk, assign to PC.Order Category. Save the change order then review the progress of the workflow using the Workflow Tasks tab.
2.) Scroll to the bottom of the task list and click on the RequestForm task. If you do not see this task Refresh the task list by going to View->Refresh:

- **Note:** The requester will also receive a notification to login to their worklist and fill out an online request form. This notification will be based off of the notification method specified in his/her contact record in Unicenter Service Desk. Assuming the notification method is email, the email comes from the account defined within Service Desk:

The requester can either login to the Worklist using the RequestForm Link in the Change Order, or alternatively they can click on the link within the email.

3.) Login to the CA Workflow Worklist interface as the requester:

Copyright © 2006 CA. All rights reserved. All trademarks, trade names, service marks and logos referenced herein belong to their respective companies.
• **Note**: Make sure you use the same case for the User Name as defined in eIAM. If you use a different case, you will be able to login to the Worklist however your Worklist will be empty.

4.) In the task list the Requester should see a single RequestForm task. Select the Perform link on the right side of the screen to fill out the form and continue the workflow process:

5.) Fill out and submit the form. Upon submission you should be sent back to the worklist screen where you will see confirmation that the task is now complete:
Once you have submitted the request, logout of the Worklist.

6.) Return to the Change Order in Unicenter Service Desk to see how the process has advanced in the workflow. After the form was filled out an email from CA Workflow was sent to the Approver and requested that they perform the next Approval Task. The list of workflow tasks in Unicenter Service Desk are shown below.

- Note: The approver will also receive an email notification to login to their Worklist and fill out an online approval form. This notification will be based off of an event within CA Workflow. The email comes from the account defined within CA Workflow:

The approver can either login to the Worklist using the Approver Form Link in the Change Order, or alternatively they can click on the link within the email.

Copyright © 2006 CA. All rights reserved. All trademarks, trade names, service marks and logos referenced herein belong to their respective companies.
7.) Login to the CA Workflow worklist interface as the Approver contact and click Perform to view the approval form for the requested PC configuration.

The form you see is a simple text form that requires no design within the CA Workflow Design Environment. This is an example of the options you have when designing forms. Once you see the form click Yes to approve the request and you will then see confirmation back on the main worklist screen:

7.) Review the Change Order again in Unicenter Service Desk to see further updates to the workflow tasks tab. Each activity in the workflow process is listed on this tab. The next step in the workflow is to send an email notification to the end user letting them know that their request was approved:
8.) Assuming all steps executed successfully you should notice the last step in the workflow is to close the ticket. In a production environment this may instead trigger a procurement system to place an order or notify the correct person to continue processing this order.

- **Note:** For the CA Workflow to close the ticket all the workflow tasks must first complete. Because of this you may occasionally see a delay in the status change of the Change Order. Try refreshing the ticket by clicking View- >Refresh to see the change

Also review the activities tab to see all updates CA Workflow performed within Unicenter Service Desk such as manual notifications and closing the ticket.
III. Troubleshooting and Additional Resources

Log Files

- **Install Log**: $NX_ROOT/site/wekinstall.log shows errors that occurred during the workflow installation.
- **Workflow Server Log**: View in Workflow Design Environment Process Designer/Process Manager Tab/Server Log. Be sure logging is turned on by hitting the play button.
- **Process Instance History**: The Process Instance History shows all the tasks within an ongoing or completed workflow process instance. An instance is created each time that specific workflow process definition runs. Always review this log when troubleshooting problems with a particular workflow process definition. Check to see the values of key variables and the order that tasks are started and completed. To navigate to the Process Instance History do the following…

  Within the CA Workflow Design Environment click on the Process Manager Tab then Process Instances and Select the particular workflow process definition from dropdown and hit green play button. This will display all the instances within the specified time period for the process definition in the drop down. By selecting one of the instances you will see all of the external variables for that process definition and the values for that instance. Double click any instance to see more detail. This will bring up the Process Designer tab and show that instance. Here you can view all the attributes for that instance as well as the History Tab which displays all the activities for this instance.

  - **Note**: If these columns become too large to view within the interface, select/highlight the column, hit ctrl + C to copy the line, then paste it into a text editor for viewing.
- **Tomcat Server Logs**: $NX_ROOT/log/pdm_tomcat.log, stderr.log, stdout.log, pm_log.YYYY-MM-DD.txt, wl_log.YYYY-MM-DD.txt
  - **Note**: The most significant runtime errors within the Workflow are logged in pdm_tomcat.log, i.e. bad usernames, database errors, etc.
- **Web Services Logs**: wsactorSoapRequest.xml, wsactorSoapResponse.xml
  - Shows the last request/response
- **Ingres Logs**: errlog.log
- **Unicenter Service Desk Logs**: stdlog.x (where x = 0 - 9)

Install/Uninstall

- To uninstall/reinstall CA Workflow manually:
- Export any CA Workflow definitions you would like saved. (To export process definitions, navigate to the Process Manager tab, select the appropriate workflow and then go to the File Menu and choose Export)
  - **Note**: If you import a definition into a new installation, you will have to remap the Change / Issue categories to these definitions.
- Uninstall CA Workflow from a dos prompt by:
  - `cd $NX_ROOT\site\Workflow\uninstall`
  - `java -cp uninstall.jar run –silent`
- Reinstall it by running pdm_configure. The configuration process will reinstall CA Workflow.

### Additional Resources
- **CA Workflow Online Help**: View in Workflow Design Environment Process Designer/Help Menu/Help Topics. The online help has very good examples to walk through and it is highly recommended to go through these examples when learning the Process Designer.
- **Look for CA Workflow Education Classes**: Search for upcoming CA Workflow classes at [ca.com/education](http://ca.com/education)

### Common Errors
- **Unable to connect to PM error message when connecting to CA Workflow Design Environment**:
  ![Image](image_url)

This is the most common error associated with workflow. This typically means that the Process Manager Service or the authentication service associated with CA Workflow is not running; however there could be other causes. This error most often occurs in vmware as the iTechPoz services associated with authentication may not start after a reboot. Other things to check would be:

- Ensure that the iTechPoz services are running in Services Manager (on the machine hosting eIAM)
- Ensure that the two eTrust Directory services are running (on the machine hosting eIAM)
- Ensure that the Service Desk service is up and running in Services Manager
- Verify that the Workflow configuration completed successfully when installing the Service Desk primary server.
  - You can verify this by checking the configure.log file.
- If you are trying to connect to Workflow installed on a remote client machine, first make sure that you can connect to Workflow from the primary server before attempting to connect from a remote client machine. Until you can connect to Workflow from the primary server, you will not be able to connect from a remote client.

- Make sure Tomcat is started (verify that the Service Desk services are started, and look for pdm_tomcat_nxd specifically). If it is already started, try issuing a restart by running:
  - `pdm_tomcat_nxd -c STOP`
  - followed by
  - `pdm_tomcat_nxd -c START`

Copyright © 2006 CA. All rights reserved. All trademarks, trade names, service marks and logos referenced herein belong to their respective companies.
- Verify that you can login to eIAM as the ServiceDesk user (or whatever user you are attempting to login to the Workflow as).
  o If you cannot login to eIAM as the ServiceDesk user, login as the eIAM Administrative user, check to make sure the ServiceDesk user is defined.
  o If you cannot login as any user, please verify passwords and also verify that all eTrust Directory services are started on the machine.
- Verify the port to be used by CA Workflow/Tomcat is not already in use. (This can be accomplished by running netstat). If you changed the port, make sure this port is reflected in the “Server Address” portion of the CA Workflow Design Environment login screen.
  o By default CA Workflow/Tomcat should be using port 8080. To verify the port Workflow is using you can check options manager within Service Desk, $NX_ROOT\nx.env, and/or $NX_ROOT\bopcfg\www\CATALINA_BASE\conf\server.xml. All of these should show the same port information.
  o If the port is correct, and it is not in use, try copying and pasting the “Server Address” url link in a browser and check if it brings the Directory Listing with that specified port in the URL. In case it doesn’t recognize the port then the page cannot be displayed error will pop up.
  o Additionally, see if you can login to the CA Workflow Worklist (http://< machinename>:<Tomcat Port>/wl)
- Verify that no other instances of java are running, and if they are kill the remaining process instances
- If you have checked all of the above to no avail, check the log files for additional information, specifically pdm_tomcat.log.

**Refresh issues in Unicenter Service Desk Web Interface**

When saving a Change Order or Issue in Service Desk web interface you may see the following error “There is a problem accessing CA Workflow…” This is a refresh problem that occurs when trying to view the “Workflow Tasks” tab just after the ticket is saved and the workflow instance is being kicked off. To get around this just go to the View Menu and select Refresh. The best way to avoid this is to not go immediately to the Workflow Tasks tab after saving a ticket.

**Inability to attach Process Definitions to Service Desk Change or Issue Categories**

If you create a new process definition in CA Workflow without specifying certain parameters you will not be able to link it to a Change Order or Issue Category in Unicenter Service Desk. The CA Workflow definitions list in Unicenter Service Desk only displays those process definitions that have an external input parameter called `usd_persid`. This tells Unicenter Service Desk that the process is specifically for Unicenter Service Desk and not other products. Therefore ensure that your process definitions that should be triggered by a Change Order or Issue have the default `usd_persid` parameter. (This can be done by right mouse clicking on your process definition as shown below and selecting

Copyright © 2006 CA. All rights reserved. All trademarks, trade names, service marks and logos referenced herein belong to their respective companies.
- **Incorrect Workflow Login Parameters in Service Desk Options Manager**
  
  One of the most common errors is to enter incorrect parameters in the Service Desk Options Manager. The parameters on this screen should be an administrator user in CA Workflow along with the correct userid and password. If these parameters are incorrect the following error will be displayed and workflows cannot be initiated.

  Error “There is a problem accessing CA Workflow – please try again or contact the administrator. Details: Error accessing PM Service at: http://SERVERNAME:8080/pm/services/pmService

  Error logging in user wf_admin

  The relevant Service Desk options are “cawf_username” and “cawf_password”.

- **Incorrect Web Service Actor URL**

  If you get errors relating to problems connecting to the web service, you may have an incorrect url pointing to the Service Desk R11 WSDL. This will most likely show up in the Login process definition. Navigate to the Actors tab on the left and select the Unicenter_Service_Desk_Web_Service from under theWebService folder.
• **Duplicate data types**

If you are having problems running the workflow and more specifically problems using the Unicenter Service Desk web service, review the Data Types tab on the left side of CA Workflow. Drill down into the Unicenter_Service_Desk_Web_Service data type and ensure that you do not have any duplicate data types (as seen in the screen shot below). If you do have duplicate data types either remove the duplicates or remove the web service actor, log out, log back in and re-add the web service actor.

![Screen shot of Duplicate data types](image)

• **Process still running**

This may be caused by having wrong login parameters in the Login building block. To confirm or change these parameters review the section on “Configure Workflow” in part II of this document.

![Screen shot of Process still running](image)

IV. Enhancements

**Creating a Duplicate of the Sample Workflow**

Before performing any of these enhancements its best to take a copy of the sample Order PC workflow and use that copy to make enhancements. Follow the steps below to ensure that you keep your working sample intact.

Copyright © 2006 CA. All rights reserved. All trademarks, trade names, service marks and logos referenced herein belong to their respective companies.
In the CA Workflow Design Environment, highlight the Order PC workflow on the process manager tab.

While still on the process manager tab, navigate to the File Menu and choose Export. Save the XML export of the Order PC workflow. This gives you a backup of the Order PC process in XML but you also have the existing process definition in the Design Environment itself.

To bring in a duplicate process definition to enhance, you need to do the following. From the File menu in the CA Workflow Design Environment, select Import->Process Definition. Select the xml file that you just exported. The new definition should now be imported. During the import process the Design Environment will prompt you to give the definition a new name, you may want to name it ‘Order PC Advanced’ or similar. Use this process for all of the below enhancements.

**Update the Unicenter Service Desk Activity Log**

A common enhancement for the sample workflow is to log activities in the Unicenter Service Desk change order/issue. The following steps will cover how to add a node that logs a comment in the Change Order after the request for approval has been sent to the approver. This is a basic example of how to take advantage of the provided process definitions and log an activity as well as better understand the CA Workflow application.

**Create an Actor for the Log Activity Process**

- In the CA Workflow Design Environment open the Order PC Advanced process Definition.
- Select the actors tab on the left side of the screen.
- Highlight the Processes folder under Actor Types/Actors. From the File Menu select New->Actor
- From the Process Actor window, select Log Activity - Service Desk from the drop down menu and click Ok. This will create the new Process Actor under the Processes folder. Out of the box, Unicenter Service Desk provides a separate Log Activity process that makes it simple for other process definitions to update the Change Order Activity Log. This actor is necessary for a process definition to call this log activity process.

**Create a Role for initiating the new Activity**

- Navigate back to the Process Designer window where the Order PC Advanced process definition is located.
- Click the Roles tab below the process definition on the right side of the screen.
- A new Role needs to be added to initiate the Log Activity workflow from the Order PC Advanced process. This role needs to link to the new actor that was created in the previous step. On the Roles tab click the Add button. Fill out the name and description and select the Log Activity – Service Desk actor then click OK.
Add the new Activity Node

- From the Process Designer Screen select the Activity Node icon from the toolbar at the top of the screen. Then click the location on the screen where you want to place the item, preferably next to the Email Approval Form to Approver Send Event node.

- Delete the connector line from the Email Approval node to the Approve Form node. Then add new connectors to place your new node between the Email Approval and Approve Form nodes.

- Double click the new node and fill out the Properties tab with basic information about this node. See screen shot below for default values of the “Log Comment” node.
• Within the Log Comment activity node, select the Workitem tab. In the Assign to Role field select the Activity Log role that you created previously. The start process operation should be selected to kick off the log activity process when this node is reached in the workflow. The input parameters are the values passed to the Log Activity method that will initiate the update in Service Desk via the web services. A list of the appropriate values and an explanation is provided below.

  o Context- This needs to be a value that is a placeholder for the function call. A unique value needs to be sent so that multiple web services calls don’t conflict. This can easily be done by using the following parameter: `concat("LogActivity", $ProcessId)` . This will concatenate the name of the activity that is being performed and the id of the process definition. For context in other workitems just replace “LogActivity” with the name of the activity you are performing.

  o TICKETHANDLE- the ticket handle is the unique id (persid) of the change order that is used for this workflow process. This value is used in several other parts of the workflow. Double click the value expression column in the tickethandle row. Find the usd_persid in the variables list in the right column. Double click the variable to get it to appear in the top window of the Expression Builder screen.

  o Comment- This is the comment that will be inserted into the activity log. This is a string value so the comment must be entered in double quotes. The comment used in this example is “Your request has been received and is awaiting approval.”

  o Logtype- Because the node logs a comment the value is “LOG”. There are several other logTypes that can be used for more details on those values review the Web Services Guide and Chapter 3 on Performing Common Tasks.

  o Internal (not pictured)- The internal parameter states if this comment is an internal only activity log or public. If the value is True then the activity will be internal only. For this example the comment will be public and a value of False must be sent. Since this is a Boolean variable “False” will not work, a function must be called to pass this value. Double click on the value column to bring up the expression builder and select false() from the functions list. This function will pass the correct Boolean False value to the workflow.
While still in the log comment node, navigate to the Exceptions tab (see above). The exceptions tab tells the workflow engine what to do if an error occurs for this activity node. In this example we set the exception to “Remove workitem and continue” which means that this node will be skipped if a problem occurs and the rest of the workflow will continue. Select the appropriate choice from the list of exception processing options.

### Update Unicenter Service Desk and Test

- The next step is to create a new category in Unicenter Service Desk and link it to the new Order PC Advanced workflow that was created (assuming you made a copy of the original Order PC Workflow). For details on doing this review the previous section in this document titled Configure Change Order in Service Desk.

- Finally test the workflow and ensure that the activity log is updated with the appropriate information and the rest of the workflow continues normally. You should see similar results in the workflow tasks and activities tabs within the Unicenter Service Desk Change Order.

### Set due dates for tasks

A real world requirement for most business processes are due dates for tasks. This example will go over setting a due date for a given task and how the workflow can react to an overdue task. You will further enhance the Order PC Advanced workflow with the new functionality.
Advanced workflow by adding a due date and associated sub processing to the Approve Form node. This will give the approver x amount of time to perform the task before the task is removed from their queue and reassigned to a new group of users.

Create a copy of the existing Order PC Process Definition

- If you haven’t done so already create a copy or backup of the existing Order PC process definition. See the above section entitled “Creating a Duplicate of the Sample Workflow” for more information.

Create a new Group in eIAM

- Login to eIAM as the ServiceDesk user in the Service Desk application.
- From the Manage Identities select the Groups option at the top of the screen.
  - Create a new Group by clicking on the add group icon under the User Groups section on the bottom left of the screen. Fill out the name and description for the group. In this example the group is named “Approvers Group”. Save the group.
  - While still in eIAM, navigate back to the Users section under Manage Identities
  - Add several users to the newly created group. It may be advantageous to add new users in eIAM just to make this exercise more realistic.
- Logout of eIAM

Create a new Role

- In the Workflow Design Environment open the Order PC Advanced process Definition.
- Create a new Role within this process definition by clicking on the Add button on the role tab. Link this role to the Global User List actor and your newly created group. In this example the Role is named “Approver – Overdue”. Save the role when complete.
Add a due date and sub processing

- Double click the Approve Form Node and select the Due Date tab.

- Fill out the due date tab with details on when this task should be completed. To make testing simple the due date is set to 1 minute after this node is reached in the process definition. Also select the “Remove workitem and continue” processing option. This option will remove this task from the currently assigned users queue and continue in through the workflow. Click OK to go back to the main workflow.

- This step will cover adding a sub process to do the work of reassigning this task and notifying the new assignees. Double click on the new calendar icon that appears on the Approve Form node. This node should bring up a new tab in the process designer window named “Approve Form: Due Date”. Essentially this is a new process definition that will only be called when the Approve Form task is over due. Currently all you should see is a start and stop button and no activities.

- Return to the Order PC Advanced process definition by clicking the Main tab in the Process Designer window.

- Copy the Email Form to Approver and Approve Form nodes and paste them into the new workflow. To copy the nodes right click on the node then select copy and paste it on the Over Due tab. After the nodes are on the Over Due tab connect them to form a complete process from start to finish, like the screen shot below.
• Double-click the new Email Form in the Due Date tab. Change the name and description of the node to reflect that this is a new notification to an approval group. On the workitem tab change the role to the new role you created for the approval group. Click Ok when complete.

• Double-click the new Approve Form node in the Due Date tab. Change the name and description of the node to reflect that this is a different node. On the workitem tab change the role to the new role you created for the approval group. Most importantly modify the Due Date settings on the Due Date tab. If you leave the settings as is the task will continually be reassigned. Set the first drop down in the Due Date tab to empty to turn off this trigger. Click Ok when complete.

• Save the changes to this Process Definition. Recall that clicking ok within a node or workitem saves the changes to that node but does not update the process definition as a whole!

**Test in Unicenter Service Desk**

• Test your updated process definition by creating a new change order in Unicenter Service Desk with the appropriate change category. The workflow should proceed normally until the Approve Form task. If the task is not performed before the due date then the new workflow tasks are kicked off. The members of the Approval Group are sent an email and the new Approval task is inserted into their queue. The rest of the process will occur as normal. Therefore you should see two new tasks and a total of 12 tasks in the Workflow Tasks tab in the change order.
Retrieve a User’s Supervisor from Unicenter Service Desk

Another common enhancement is to retrieve a user’s supervisor from Unicenter Service Desk for approvals. The following steps will give you the basic overview of what needs to be done to retrieve this type of information from Service Desk via the CA Workflow Design Environment. The actually stand alone process definition is also provided as a further example of a common workflow.

Create a copy of the Get Object Information Process Definition

- This is a very good starting point for a new process definition that will interact with Unicenter Service Desk. Make a copy of this process and use this as a starting point. This eliminates the manual steps involved with first creating a workflow for Unicenter Service Desk such as steps to login to the Web Service. Be sure to rename this process to “Get Supervisor Info” or similar.

High level tasks to retrieve a user’s Supervisor

- The following are the high level tasks to perform in a process definition to retrieve a Supervisor given an end user’s userid.
  - Login to Unicenter Service Desk and retrieve the SID (session ID) using the login web service method.
  - Ensure that SID is valid and login actually occurred
  - Query Unicenter Service Desk using the doSelect or doQuery method from the Unicenter Service Desk web services. This is where the real work is done in this process definition. Each of these methods query Unicenter Service Desk for any specified information relating to an object that you are looking for. Ensure to review the web services guide prior to using this method. The key pieces of information you will need to pass this method are as follows:
    - the object you are querying: cnt for contact
    - the where clause to filter the search: userid='enduserid'
    - the number of results to return: 1 (assuming userids are unique)
    - the attributes to return in an ArrayofString: supervisor_contact_uuid.persistent_id, supervisor_contact_uuid.userid
  - Parse the xml results returned from the previous task. It is very helpful to reuse XPath XML parsing from other out of the box building blocks such as the Order PC process definition. The post tab of the Save Attribute Info task in Order PC process definition has about 9 examples of XML parsing that can easily be modified for different uses.
  - Logout of Unicenter Service Desk to properly close the session using the logout web service method.

Test in CA Workflow Worklist

- After you have completed your new process definition you can test it outside of Unicenter Service Desk. To do this login to the CA Workflow Worklist as a user who is in the Workflow Process Initiators group (i.e. ServiceDesk). From the CA Workflow Templates tab select your new process definition and click start. This will show a form with fields for each of the input parameters of the process. Fill out the appropriate parameters and click start. This will start the process. Recall that if you did not create a form or any tasks in a users queue you will see no output. You must go into the CA Workflow Design Environment to review the instance and history for any output.
Import Get Supervisor Process Definition

- A version of the previously described process definition has been built and is available as an xml file to import into the CA Workflow Design Environment. The file, getsupervisor031306.xml, is available from the Integration Page on the Implementation Best Practices guidelines, or from the Technical Document Index on the Unicenter Service Desk home page, on SupportConnect. This process definition takes either the user’s ‘userid’ or contact handle (i.e. persistent_id) and then outputs the supervisor’s userid and contact handle. Please import the process and review the workflow step by step until you understand the process. This definition is ready to use and does not need any modification. It is designed to be called by other process definitions and by default cannot be called directly from a Unicenter Service Desk Change Order or Issue.

Modify Exception Handling

- There are a number of ways that exceptions, or irregular situations, within the CA Workflow can be handled. For example, when you are executing a process definition, there is an actor fault when one of the activity nodes is called within the Workflow. When the fault occurs, you can specify whether you want to:

  o Remove workitem
  o Remove workitem and continue
  o Leave workitem
  o Reassign workitem: (*Note: This does not mean the task can be reassigned to another user. This means that the task will be given to the same user another time. If you would like to reassign the workitem please see CA Workflow online help)
  o Terminate process
A Workitem is the actual work, or activity, that is performed within a Node. See the Workitem tab for each individual node for more information.

Create / Update Forms

CA Workflow gives you the ability to create or update forms which can be used in conjunction with your process definitions. A form can be displayed to an end user to allow them to submit information, and this data can then be stored in variables and passed to other nodes in the Workflow.

To create a new form or modify an existing one, login to the CA Workflow Design Environment. Go to Process Manager Tab/Process Definitions/Click on an existing WF definition. Navigate to the Forms Tab on the lower portion of the screen:

To add a new form, click on the Add button on the right hand side. To modify an existing form, click on the form name and hit Update. You will then be presented with the form designer. Below is the form designer interface showing us the Order PC Form. You will see the Form Tree showing on the left hand side:
The toolbar on the left hand side of the Form Designer contains the following buttons, which are displayed top to bottom. You can drag and drop these over to customize your form:

- **Group Box**: Adds a new Group Box control to the form. On a form, controls are organized into logical groups. Use the Group Box to group the controls in your form. Depending on your form attributes, the controls in a Group Box appear as tabs or windows.
- **Input**: Adds a new Input control to the form. An Input control displays as a field that the user can enter information into.
- **Secret**: Adds a new Secret control to the form. A Secret control provides a field where the user enters information, but the information is masked. This control is commonly used for password fields.
- **Output**: Adds a new Output Control to the form. The Output control provides a read-only text field.
- **TextArea**: Adds a new TextArea control to the form. A TextArea control is a text box where the user can enter a large amount of information.
- **Submit**: Adds a new Submit control. A Submit control is a button that lets the user submit the form information to the workflow.
- **Select**: Adds a new Select control. The Select control is group of items that the user can select. The labeled items appear as either check boxes or a select box, depending on the attribute settings.
- **Select1**: Adds a new Select1 control. The Select control is group of items from which the user selects only one.

You can customize the layout and behavior of the forms using either predefined attributes or optional attributes, as displayed in the attribute table:

- **Predefined**:
  - **Id**: The form control identification name. This name does not appear to the form user (workflow actor). You should create a descriptive identification name for each form.
  - **Label**: The form label. This is the name for the form that appears in the form tree and to the form user (workflow actor).
  - **Description**: The form description

- **Optional**:
  - **Appearance**: Sets the appearance and behavior of the groups when displayed to the form user (workflow actor). Possible values are: full, compact, or minimal:
    - **Full**: Groups appear in two groups per row. The width of each group does not adjust to fit the browser window size.
    - **Compact**: Groups are allowed to float in the browser window; that is, the width of the group and the width of the browser window determine the number of groups per row, which will automatically adjust if the browser window size is changed.
    - **Minimal**: Groups display in the browser as tabs.
  - **Help**: Additional text visible to the form user (workflow actor). The text displays under the form label. The text should either describe the form or help the user complete the form properly.
  - **Stylesheet**: The URL to the standard HTML .css stylesheet to attach to the form. If no stylesheet is specified, the default stylesheet is used.

Copyright © 2006 CA. All rights reserved. All trademarks, trade names, service marks and logos referenced herein belong to their respective companies.
Once you are finished adding or modifying attributes to your form, you can preview your changes before saving them and incorporating them into your process definition. Once you are sure of your changes, be sure to hit “ok” within the Form Designer to save the form, then hit save again in your process definition to ensure your form changes are saved.

For more information on using the Form Designer, see the online help.

**Integrating CA Workflow with Other Applications**

CA Workflow allows you the capability to seamlessly integrate with other applications. Integration can be done in the following ways, with the use of Actors:

Command Line, JavaScript, JavaObject, WebServices:

If the application(s) you would like to integrate with have any of the above interfaces, then the CA Workflow has the capability to integrate with it.

For more information on Actors, please see the online help, section entitled: “Actors Overview”